
Extended Primitives
 Learning Objectives
After completing this chapter, you will be able to:
• Understand Bend modifier
• Understand Taper modifier
• Create and edit extended primitives
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INTRODUCTION
In this chapter, you will learn to create complex 3D shapes using extended primitives. Also, 
you will learn in detail the usage of the Bend and Taper modifiers and different snap controls.

MODIFIERS
In 3ds Max, modifiers are used to apply various types of functions or effects on an object. There 
are different types of modifiers that perform different functions about which you will learn in 
the later chapters. In this section, you will learn about the Bend and Taper modifiers.

Bend Modifier
The Bend modifier is used to bend an object upto 360 degrees along the X, Y, or Z axis. To 
apply the Bend modifier on an object, select the object and choose Modifiers > Parametric 
Deformers > Bend from the menu bar. Alternatively, you can select the object in the viewport 
and choose the Modify tab from the Command Panel; the Modifiers List drop-down list will 
be displayed. Select OBJECT-SPACE MODIFIERS > Bend from the Modifier List drop-down 
list; the Bend modifier will be displayed in the modifier stack, refer to Figure 3-1. Also, the 
Parameters rollout will be displayed in the Modify panel, as shown in Figure 3-2. The areas in 
the Parameters rollout are discussed next.

Figure 3-2  The Parameters 
rollout of the Bend modifier 

Figure 3-1  The Bend modifier 
displayed in the modifier stack

Bend Area
The options in the Bend area are used to set the parameters to bend an object. The Angle spinner 
is used to define the angle of the bend along the X, Y, or Z axis. The Direction spinner is used 
to define the direction of the bend.

Bend Axis Area
The options in the Bend Axis area is used to define the axis, which needs to be bent. By default, 
the Z radio button is selected. As a result, the object will be bent about the Z axis. You can also 
select the X or Y radio button. Note that the axis to be bent should be local to the bend gizmo 
instead of the selected object.

Limits Area
The options in the Limits area are used to apply constraints to the bend effect. Select the Limit 
Effect check box to make the options in this area active. By default, value in the Upper Limit 
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and Lower Limit spinners is zero. The Lower Limit and Upper Limit spinners are used to 
specify the bending limits of the modifier from its center point.

Taper Modifier
The Taper modifier is used to taper an object by scaling it on both ends. After applying this 
modifier, one side of the object will be scaled up and another will be scaled down. To apply the 
Taper modifier, choose Modifiers > Parametric Deformers > Taper from the menu bar; the 
Taper modifier will be displayed in the modifier stack, refer to Figure 3-3. Also, the Parameters 
rollout will be displayed in the Modify panel, as shown in Figure 3-4. The areas in this rollout 
are discussed next.

Figure 3-4  The Parameters 
rollout of the Taper modifier

Figure 3-3  The Taper modifier 
in the modifier stack

Taper Area
The options in the Taper area are used to set the parameters for scaling the shape of an object. 
The Amount spinner in the Taper area is used to define the amount of taper. The Curve spinner 
is used to define the curve applied to the gizmo, and it helps in creating different shapes of the 
taper. You can set the values of the Amount and Curve spinners from -10.0 to 10.0.

Taper 	Axis Area
The Primary group in the Taper Axis area is used to define the central axis of the taper. By 
default, the Z radio button is selected in the Primary group. As a result, the Z axis is used as the 
central axis for the taper. You can also specify the X or Y axis as the central axis for the taper 
by selecting the X or Y radio button in the Primary group. The Effect group is used to define 
the direction of the taper from the primary axis. By default, the XY radio button is selected in 
the Effect group. As a result, the direction of the taper will be along the XY plane. You can also 
specify the direction of taper along the X or Y axis by selecting the X or Y radio button from 
the Effects group. The radio buttons in the Effect group change according to the selection of 
the primary axis. You can select the Symmetry check box in this area to create a symmetrical 
taper around the primary axis. 

Limits Area
The options in this area are same as discussed in the Bend modifier.
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EXTENDED PRIMITIVES
In 3ds Max, there are some complex 3D geometric shapes, which can be used to create 3D objects. 
These shapes are known as extended primitives. The extended primitives are chamfer box, 
spindle, hedra, and so on.

To create an extended primitive, you need to choose Create > Geometry from the Command 
Panel; a drop-down list will be displayed with the Standard Primitives option selected by default. 
Now, select the Extended Primitives option from the drop-down list. Activate the viewport in 
which you want to create the primitives and then choose the corresponding tool from the Object 
Type rollout. In this section, you will learn to create and modify the extended primitives using 
various tools available in the Object Type rollout.  

Creating a Hedra
  Menu bar:	 	 Create > Extended Primitives > Hedra	     	  
  Command Panel:	 Create > Geometry > Extended Primitives >	  
 			   Object Type rollout > Hedra 		      	

To create a hedra, activate the viewport and make sure that the Extended Primitives option is 
selected from the drop-down list in the Command Panel. Now, choose the Hedra tool from the 
Object Type rollout; the Name and Color and Parameters rollouts will be displayed, as shown 
in Figure 3-5. Now, press and hold the left mouse button in the viewport to define the center 
point of the hedra, and then drag the cursor to define its radius. Release the left mouse button 
to get the required radius; a hedra will be created, as shown in Figure 3-6. 

Various rollouts used to create and modify the hedra are discussed next.

Tip
 If you are creating an extended primitive that requires multiple steps, you can pan or orbit 
the viewport in between the steps. To pan the viewport, drag the cursor with the middle-mouse 
button or mouse wheel held down. To rotate the viewport, press and hold the ALT key and 
then drag the cursor with middle-mouse button or mouse wheel held down.

Note
1. The options in the Name and Color rollout of all the extended primitives are same as 
those discussed in the Box tool of Chapter 2.

2. After creating an extended primitive, if you right-click in the viewport to exit the tool, the 
Parameters rollout will disappear from the Create tab. In such a case, to modify the parameters 
of the primitive, select the primitive in the viewport and choose the Modify tab from the Command 
Panel; the Parameters rollout will be displayed.  

Parameters Rollout
The parameters in this rollout are discussed next.

Family Area
The options in the Family area are used to define various types of hedra, refer to Figure 3-7. 
By default, the Tetra radio button is selected which is used to create a tetrahedron. You 
can select the Cube/Octa radio button to create a cube or octahedron. Note that the hedra 
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created will depend on the value entered in the spinners in the Family Parameters area. If 
you select the Dodec/Icos radio button, a dodecahedron or icosahedron is created. Select 
the Star1 and Star2 radio buttons to create two different star-like polyhedra.

Figure 3-5  Various rollouts to create a hedra Figure 3-6  A hedra displayed in the viewport

Figure 3-7 Five basic shapes of hedra

Family Parameters Area
The two spinners in this area, P and Q, are used to modify the vertices and faces of a 
polyhedron. They are related to each other and their combined value can be equal to or less 
than 1.0. When you set maximum values in P and Q spinners, one parameter represents all 
vertices while the other represents all facets. 

Axis Scaling Area
A polyhedron can have three shapes of polygonal facets: triangle, square, and pentagon. 
The P, Q, and R spinners in this area control the axis of reflection for one of the facets of a 
polyhedron. By default, the value in these spinners is 100. If you change the values in these 
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spinners, they will push the facets in the object or out of the object. On choosing the Reset 
button, the values in these spinners will be reset to 100.

Vertices Area  
The options in the Vertices area determine the internal geometry of each face of a polyhedron. 
By default, the Basic radio button is selected. As a result, facets are not subdivided and thus 
have minimum vertices. On selecting the Center radio button, an additional vertex is created  
at the center of each facet. If you select the Center and Side radio buttons, a vertex is created  
at the center of each facet and at the edges of all the facets. To see the internal edges, you 
need to convert the polyhedron object into the Edit Mesh or Edit Poly modifier. You will 
learn about the Edit Mesh modifier in the later chapters. 

Radius
The Radius spinner is used to modify the radius of a polyhedron.

Creating a Chamfer Box 
  Menu bar:	 	 Create > Extended Primitives > Chamfer Box	  
  Command Panel:	 Create > Geometry > Extended Primitives > 	  
			   Object Type rollout > ChamferBox		

A chamfer box is similar to a box in the standard primitives 

Figure 3-8  Various rollouts to create 
a chamfer box

with the only difference is that it has beveled or rounded 
edges. To create a chamfer box, activate the viewport and 
choose the ChamferBox tool from the Object Type rollout; 
the Name and Color, Creation Method, Keyboard Entry, 
and Parameters rollouts will be displayed, as shown in 
Figure 3-8. 

Now, press and hold the left mouse button at a point in the 
viewport for defining the first corner of the chamfer box, 
and drag the cursor to define its length and width. Release 
the left mouse button to get the desired length and width. 
Next, move the cursor up or down to define its height, 
and click on the viewport to get the desired height. Move 
the cursor to define the fillet and click on the viewport to 
get the fillet or chamfer; a chamfer box will be created, as 
shown in Figure 3-9. 

Various rollouts used to create and modify a chamfer box 
are discussed next.

Creation Method Rollout
There are two radio buttons in this rollout. By default, the 
Box radio button is selected. As a result, a chamfer box is 
created with individual settings for length, width, and height. You can select the Cube radio 
button to create a chamfer box of equal length, width, and height. 
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Parameters Rollout
The options in this rollout are used to modify the chamfer box. The Length, Width, and Height 
spinners are used to specify the length, width, and height, respectively, of a chamfer box. The 
Fillet spinner is used to bevel the edges of a chamfer box. Higher the value of the Fillet spinner, 
more refined will be the fillet on the edges of a chamfer box. The Length Segs, Width Segs, and 
Height Segs spinners are used to define the number of segments along the length, width, and 
height, respectively of a chamfer box. The Fillet Segs spinner is used to specify the number of 
segments in the fillet of a chamfer box. 

By default, the Smooth check box is selected. As a result, the chamfer box will be smooth at 
rendering, as shown in Figure 3-9. If this check box is cleared, a chamfer box with beveled edges 
will be created, as shown in Figure 3-10. 

Figure 3-9  A chamfer 
box with rounded edges

Figure 3-10  A chamfer 
box with beveled edges

Creating a Chamfer Cylinder
  Menu bar:	 	 Create > Extended Primitives > Chamfer Cylinder	  
  Command Panel:	 Create > Geometry > Extended Primitives > 	  
			   Object Type rollout > ChamferCyl			

The chamfer cylinder is similar to the cylinder in the standard primitives. The only difference is 
that the chamfer cylinder has beveled or rounded edges. To create a chamfer cylinder, activate the 
viewport and choose the ChamferCyl tool from the Object Type rollout; the Name and Color, 
Creation Method, Keyboard Entry, and Parameters rollouts will be displayed.

Next, press and hold the left mouse button at a point in the viewport for defining the center 
of the base of the cylinder and then drag the cursor to define its radius. Release the left mouse 
button and move the cursor up or down to define its height. Click on the screen to get the 
desired height and move the cursor to define the fillet. Again, click on the screen to get the 
desired fillet; a chamfer cylinder will be created, as shown in Figure 3-11.

Various rollouts used to create and modify a chamfer cylinder are discussed next.

Creation Method Rollout
The options in this rollout are the same as those discussed while creating the sphere in Chapter 2.

Parameters Rollout
The options in this rollout are used to modify a chamfer cylinder. The Radius spinner is 
used to set the radius of a chamfer cylinder. The Height spinner is used to set the height of a 
chamfer cylinder. The Fillet spinner is used to bevel the top and bottom cap edges of a chamfer 
cylinder. Higher the value specified in the Fillet spinner, more refined will be the fillet along 
the cap edges of a chamfer cylinder. The Height Segs spinner is used to define the number of 
segments along the height of a chamfer cylinder. Similarly, the Fillet Segs spinner is used to 
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define the number of segments in the fillet area of a chamfer cylinder. The Sides spinner specifies 
the number of sides of a chamfer cylinder. The Cap Segs spinner is used to define the number 
of segments on each end of the cylinder. By default, the Smooth check box is selected. As a 
result, it creates a chamfer cylinder with rounded edges. If this check box is cleared, a chamfer 
cylinder with beveled edges will be created, as shown in Figure 3-12. The options available on 
selecting the Slice On check box are the same as those discussed in Chapter 2.

Figure 3-11  A chamfer cylinder 
displayed in the viewport

Figure 3-12  A chamfer cylinder with 
beveled edges

Creating a Capsule
  Menu bar:	 	 Create > Extended Primitives > Capsule		   
  Command Panel:	 Create > Geometry > Extended Primitives >	  
			   Object Type rollout > Capsule			 

To create a capsule, activate the viewport and choose the Capsule tool from the Object Type 
rollout; the Name and Color, Creation Method, Keyboard Entry, and Parameters rollouts will 
be displayed.

Now, press and hold the left mouse button in the viewport to specify the center of the first face 
and drag the cursor to define the radius of the capsule. Release the left mouse button and move 
the cursor up or down to define the height of the capsule. Click on the screen to get the desired 
height; a capsule will be created, as shown in Figure 3-13.

Figure 3-13  A capsule displayed in the viewport

Various rollouts used to create and modify the capsule are discussed next.

Creation Method Rollout
The options in this rollout are the same as those discussed in the previous chapter.



Extended Primitives		         3-9

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Parameters Rollout
The options in this rollout are used to modify the dimensions of the capsule. The Radius and 
Height spinners specify the radius and height of the capsule, respectively. By default, the Overall 
radio button is selected. As a result, the caps will also be included in the overall height of the 
capsule. However, if you select the Centers radio button, the height of the caps is not included 
in the overall height of the capsule. The Sides spinner specifies the number of sides around 
the capsule. The Height Segs spinner defines the number of segments along the height of the 
capsule. By default, the Smooth check box is selected, therefore the surface of the capsule will 
be smooth at rendering. The options available on selecting the Slice On check box are the same 
as those discussed in the previous chapter.

Creating a Spindle
  Menu bar:	 	 Create > Extended Primitives > Spindle		   
  Command Panel:	 Create > Geometry > Extended Primitives >	  
			   Object Type rollout > Spindle			 

A spindle is a type of cylinder with conical caps. To create a spindle, activate the viewport and 
choose the Spindle tool from the Object Type rollout; the Name and Color, Creation Method, 
Keyboard Entry, and Parameters rollouts will be displayed. Now, press and hold the left mouse 
button in the viewport to specify the center of the first face and drag the cursor to define the 
radius of the spindle. Release the left mouse button and move the cursor up or down to define 
the height of the spindle. Click in the viewport to get the desired height and move the cursor 
again to define the height of the conical caps. Next, click in the viewport again; a spindle will 
be created, as shown in Figure 3-14.

 

Figure 3-14  A spindle displayed in the viewport

Various rollouts used to create and modify the spindle are discussed next.

Creation Method Rollout
The options in this rollout are the same as those discussed in the previous chapter.

Parameters Rollout
The options in this rollout are used to modify the dimensions of the spindle. The Radius and 
Height spinners are used to set the radius and height, respectively of the spindle. The Cap 
Height spinner is used to set the height of the caps. By default, the Overall radio button is 
selected. The functions of the Overall and Centers radio buttons are same as discussed for the 
capsule. The Blend spinner is used to bevel the top and bottom caps. The rest of the parameters 
are same as of the other extended primitives.
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 Creating an L-Ext
  Menu bar:	 	 Create > Extended Primitives > L-Extrusion	  
  Command Panel:	 Create > Geometry > Extended Primitives >	  
			   Object Type rollout > L-Ext			 

The L-Ext or L-Extrusion is an L-shaped object. To create an L-Ext, activate the viewport and 
choose the L-Ext tool from the Object Type rollout; the Name and Color, Creation Method, 
Keyboard Entry, and Parameters rollouts will be displayed. 

Now, press and hold the left mouse button in the viewport and drag the cursor to define the 
overall length and width of the object. Release the left mouse button and move the cursor up 
or down to define the height of the L-Ext. Click in the viewport to get the desired height. Move 
the cursor again to define the thickness of the L-Ext and click in the viewport; an L-Ext will be 
created, as shown in Figure 3-15.

Figure 3-15  An L-Ext displayed in the viewport

Various rollouts used to create and modify the L-Ext are discussed next.

Creation Method Rollout
There are two radio buttons in this rollout. By default, the Corners radio button is selected. As 
a result, the L-Ext is created from one corner to another. You can select the Center radio button 
to create the L-Ext from its center to the outward direction.

Parameters Rollout
The options in this rollout are used to modify the L-Ext. The Side Length spinner is used to 
define the side length of the L-Ext. The Front Length spinners are used to define the front length 
of the L-Ext. Similarly, the Side Width and Front Width spinners specify the overall width of the 
L-Ext. The Height spinner is used to specify the height of the L-Ext. The Side Segs and Front 
Segs spinners are used to define the number of vertical segments on the sides of the L-Ext. The 
Width Segs spinner specifies the number of segments on the width or thickness of the L-Ext 
whereas the Height Segs spinner specifies the number of segments along the height of the L-Ext.

Creating a Gengon
  Menu bar:	 	 Create > Extended Primitives > Gengon		   
  Command Panel:	 Create > Geometry > Extended Primitives >	  
			   Object Type rollout > Gengon			 

To create a gengon, activate the viewport and choose the Gengon tool from the Object Type 
rollout; the Name and Color, Creation Method, Keyboard Entry, and Parameters rollouts will 
be displayed. Now, press and hold the left mouse button in the viewport and drag the cursor to 
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define the radius of the object. Release the left mouse button and move the cursor up or down 
to define the height of the gengon. Click in the viewport to get the desired height and move the 
cursor again to define the size of the fillet of the gengon. Next, click in the viewport; a gengon 
will be created, as shown in Figure 3-16.

Figure 3-16  A gengon displayed in the viewport

Various rollouts used to create and modify the gengon are discussed next.

Creation Method Rollout
The options in this rollout are the same as those discussed in the Sphere tool of the previous 
chapter.

Parameters Rollout
The options in this rollout are used to modify the dimensions of gengon. The Sides spinner is 
used to specify the sides of the gengon. Higher the value of the sides of the gengon, more circular 
will be the gengon. The Radius spinner is used to specify the radius of the gengon. The Fillet 
spinner is used to bevel the corners of the gengon. The Height spinner is used to specify the 
height of the gengon. The Side Segs, Height Segs, and Fillet Segs spinners are used to define 
the segments on the sides, height, and fillet of the gengon respectively. 

Creating a RingWave
  Menu bar:	 	 Create > Extended Primitives > RingWave	  
  Command Panel:	 Create > Geometry > Extended Primitives >	  
			   Object Type rollout > RingWave			 

A ringwave is a ring-shaped object that can have irregular inner and outer edges which can be 
animated. To create a ringwave, activate the viewport and choose the RingWave tool from the 
Object Type rollout; the Name and Color and Parameters rollouts will be displayed.

Now, press and hold the left mouse button on a point in the viewport to specify the center of the 
ringwave and drag the cursor to define its outer radius. Release the left mouse button and move 
the cursor to define the inner radius of the ringwave. Click in the viewport to get the desired 
radius of the object; a ringwave will be created, as shown in Figure 3-17.

Tip
After creating the ringwave, you can view its in-built animation by dragging the time slider 
on the track bar or by choosing the Play Animation button from the animation playback 
controls.
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Figure 3-17  A ringwave 
displayed in the viewport

The rollouts used to create and modify the ringwave are discussed next.

Parameters Rollout
The options in this rollout are used to modify the ringwave. The areas in this rollout are discussed 
next. 

RingWave Size Area
In the RingWave Size area, the Radius spinner is used to define the outer radius of the 
ringwave. The Radial Segs spinner specifies the number of segments between the inner 
and outer surfaces along the circumference of the ringwave. The Ring Width spinner is 
used to specify the width of the inner ring.The Sides spinner is used to specify the number 
of sides around the circumference of the ringwave. The Height spinner is used to specify 
the height of the ringwave and the Height Segs spinner specifies the number of segments 
along its height.

RingWave Timing Area
The options in the RingWave Timing area are used to animate the ringwave. The ringwave 
grows from the value 0 to the value specified in the Radius spinner of the RingWave Size 
area. Select the No Growth, Grow and Stay, or Cyclic Growth radio button to define the 
pattern of the ringwave growth. The values in the Start Time, Grow Time, and End Time 
spinners are used to specify the number of frames at which the ring wave starts appearing, 
reaches to its full size, and disappears, respectively.

By default, the No Growth radio button is selected. As a result, the ringwave will not grow 
over the time. It just appears at the frame number specified in the Start Time spinner and 
disappears after the frame number specified in the End Time spinner. You can select the 
Grow and Stay radio button to animate a single growth cycle. In this case, the ringwave starts 
growing at the frame number specified in the Start Time spinner, grows up to its maximum 
radius in the number of frames specified in the Grow Time spinner, and disappears at the 
frame number specified in the End Time spinner. If you select the Cyclic Growth radio 
button, the ringwave animates repeatedly. In this case, the ringwave will start to grow from 
the specified frame in the Start Time spinner. Its radius will grow till the specified frame in 
the Grow Time spinner. This cycle of start and grow of the ring wave will continue upto the 
specified frame in the End Time spinner.

Outer Edge Breakup Area
The options in the Outer Edge Breakup area are used to change the shape of the outer edge 
of the ringwave and define the breakup of the outer edge. To activate the options in this 
area, you need to select the On check box. The Major Cycles spinner specifies the number 
of major waves around the outer edge of the ringwave. The Width Flux spinner specifies 
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the size of the major wave in percentage. The Crawl Time spinner specifies the number of 
frames in which a single major wave moves around the outer circumference of the ringwave. 

The Minor Cycles spinner are used to define the number of small and random-sized 
waves in each major wave. The Width Flux spinner specifies the size of the smaller waves 
in percentage. The Crawl Time spinner specifies the number of frames in which a single 
minor wave moves around its respective major wave.

Inner Edge Breakup Area
The options in the Inner Edge Breakup area are used to change the shape of the inner 
edge of the ringwave. Also, it defines the breakup of the inner edge. To activate the options 
in this area, you need to select the On check box. The Inner Edge Breakup area has the 
same options for defining the inner edge of the ringwave as those discussed in the Outer 
Edge Breakup area for defining the outer edge of the ringwave. 

Surface Parameters Area
The Texture Coordinates and Smooth check boxes are selected by default in the Surface 
Parameters area. The Texture Coordinates check box is used to define the required 
coordinates for the mapped-material on the ringwave. The Smooth check box is used to 
smoothen the ringwave. 

Creating a Hose
  Menu bar:	 	 Create > Extended Primitives > Hose		   
  Command Panel:	 Create > Geometry > Extended Primitives >	  
			   Object Type rollout > Hose 			 

A hose is an extended primitive that can link two objects. 

Figure 3-18  A hose displayed in the viewport

It reacts to the movement of linked objects. To create 
a hose, activate the viewport and choose the Hose 
tool from the Object Type rollout; the Name and 
Color and Hose Parameters rollouts will be 
displayed. Now, press and hold the left mouse 
button in the viewport to specify the center of the 
hose and drag the cursor to define its radius. 
Release the left mouse button and move the cursor 
up or down to define the height of the hose. Click 
on the screen to get the desired height of the hose; 
a hose will be created, as shown in Figure 3-18.

The rollouts used to create and modify a hose are discussed next.

Hose Parameters Rollout
The options in this rollout are used to modify the hose. The different areas in this rollout are 
discussed next. 
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End Point Method Area
In the End Point Method area, the Free Hose radio button is selected by default. As a result, 
a free hose is created which is not bound to other objects. You can modify the height of the 
free hose by setting the value in the Height spinner in the Free Hose Parameters area. If you 
want to bind the hose with two objects, then you need to select the Bound to Object Pivots 
radio button in the End Point Method area. On selecting this radio button, the options in 
the Binding Objects area will be enabled. 

Binding Objects Area
The options in this area are used to bind two objects to the hose at the pivot point of these 
objects. The Pick Top Object button in the Binding Objects area is used to bind the object 
with the top of the hose. The Pick Bottom Object button in this area is used to bind the 
object with the bottom of the hose. When you select the objects for the top and bottom of 
the hose, the name of these objects will be displayed in the Top and Bottom labels. The 
value in the Tension spinner is used to control the tension between the bend in the hose 
and the top or bottom objects.

Common Hose Parameters Area
In the Common Hose Parameters area, the Segments spinner specifies the number of 
segments along the length of the hose. By default, the Flex Section Enable check box is 
selected. As a result, the Starts, Ends, Cycles, and Diameter spinners will be enabled. The 
values in all these spinners are a percentage of the values of the main hose. The value in 
the Starts spinner specifies the point where the flex section starts along the hose. The value 
in the Ends spinner specifies the point where the flex section ends. The Cycles spinner is 
used to define the number of cycles in the flexible section. To display all the cycles properly, 
the number of segments should be more. The Diameter spinner is used to specify the 
secondary diameter of the flexible section. 

Smoothing Area
By default, the All radio button is selected in this area. As a result, the entire hose is 
smoothened. You can select the Sides radio button to smoothen only the sides of the hose. 
If you select the None radio button, it creates a faceted surface of the hose. You can also 
select the Segments radio button to apply smoothness on the inner section of the hose.   

By default, the Renderable and Generate Mapping Coords check boxes are selected 
in this area. The Renderable check box is used to view the hose on rendering. The 
Generate Mapping Coords check box is used to automatically assign the mapping 
coordinates to an object.

Hose Shape Area
The options in the Hose Shape area are used to define the basic shape of the hose. By default, 
the Round Hose radio button is selected. As a result, a circular cross-section is created. If 
the Round Hose radio button is selected, the Diameter and Sides spinners will be activated. 
The Diameter spinner specifies the diameter of the hose. The Sides spinner specifies the 
number of sides of the hose. 

Select the Rectangular Hose radio button to create a rectangular hose; the Width, Depth, 
Fillet, Fillet Segs, and Rotation spinners below this radio button will be activated. The Width 
and Depth spinners are used to define the width and depth of the hose, respectively. The 
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Fillet spinner specifies the value by which the cross-section corners of the hose get rounded. 
The value in the Fillet Segs spinner should be higher in order to view the fillet. The value 
in the Rotation spinner rotates the hose around its local Z-axis. 

If you select the D-Section Hose radio button, a D-shaped hose is created. Also, the Width, 
Depth, Round Sides, Fillet, Fillet Segs, and Rotation spinners below this radio button 
will be activated. The Width and Depth spinners in the D-Section Hose radio button are 
used to define the width and depth of the hose, respectively. The value in the Round Sides 
spinner specifies the total number of segments along the rounded side of the D-shaped 
hose. The Fillet spinner specifies the value by which the square corners of the cross-section 
get rounded. The value in the Fillet Segs spinner should be higher to view the fillet. The 
value in the Rotation spinner rotates the D-shaped hose around its local Z-axis.

TUTORIALS
Tutorial 1

In this tutorial, you will create a 3D model of a couch, as shown in Figure 3-19, by using the 
extended primitives.			     	                	          (Expected time: 30 min)

The following steps are required to complete this tutorial:  

a.	 Create the project folder.
b.	 Create seat support.
c.	 Create back support.
d.	 Create left side of the couch.
e.	 Create right side of the couch.
f.	 Create base of the couch.
g.	 Save and render the scene.

Figure 3-19  The model of a couch

Creating the Project Folder
Create a new project folder with the name c03_tut1 at \Documents\3dsmax2020 and then save the 
file with the name c03tut1, as discussed in Tutorial 1 of Chapter 2.

Creating Seat Support
In this section, you will use the ChamferBox tool to create seat support of the couch.

1.	 Activate the Top viewport. Choose Create > Geometry from the Command Panel. In this 
panel, by default, the Standard Primitives option is displayed in the drop-down list. Select 
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the Extended Primitives option from the drop-down list and choose the ChamferBox tool 
from the Object Type rollout.

2.	 Expand the Keyboard Entry rollout and set the parameters as follows:

	 Length: 62.342	       Width: 155.575        	    Height: 22.222        	      Fillet: 6.0	

3.	 Choose the Create button; a chamfer box is created, as shown in Figure 3-20.

Figure 3-20  A chamfer box created for seat support

4.	 In the Parameters rollout, set the Fillet Segs spinner to 3.0. 
	
5.	 In the Name and Color rollout, enter seat support as the name of the chamfer box and 

press ENTER. Also, use the color swatch to modify the color of seat support by entering the 
values as given below:

	 Red: 225	        	  Green: 143	         	  Blue: 87  

Creating Back Support
In this section, you will create a chamfer box primitive to create back support of the couch.

1.	 Make sure that the Top viewport is activated and the ChamferBox tool is chosen.   

2.	 In the Keyboard Entry rollout, set the parameters as follows: 

  	 Length: 15.413       				      Height: 48.089        

	 Also, make sure the value in the Fillet spinner is 6.0.	
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3.	 Choose the Create button; another chamfer box is created.		

4.	 In the Name and Color rollout, enter back support as the name of the new chamfer box 
and press ENTER.

5.	 Assign the same color to back support that was assigned to seat support.

6.	 In the Parameters rollout, make sure the value in the Fillet Segs spinner is 3.0. 

7.	 Choose the Zoom Extents All tool to display the objects to their extent in all viewports.

	 Next, you need to align back support with seat support.

8.	 Choose the Select and Move tool and select back support if not selected, and move it in the 
viewports to align it with seat support, as shown in Figure 3-21.  

Figure 3-21  Alignment of back support with seat support

Creating Left Side of the Couch
In this section, you will create a chamfer box for left side of the couch.

1.	 Activate the Top viewport by middle-clicking in it and choose the ChamferBox tool. Now, 
in the Keyboard Entry rollout, set the values in the respective spinners as given next:

 
	 X: -80.0			   Length: 62.323		  Width: 14.506		
	 Height: 48.895	
	 	
	 Also, make sure the value in the Fillet spinner is 6.0.	Use the default values for other 

parameters.
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2.	 Choose the Create button; another chamfer box is created, as shown in Figure 3-22.  

Figure 3-22  The another chamfer box displayed in the viewports

3.	 In the Parameters rollout, make sure that the value in the Fillet Segs spinner is 3.0.

4.	 In the Name and Color rollout, enter left side and press the ENTER key. Assign the same 
color to left side that you assigned to seat support. 

Creating Right Side of the Couch
To create right side of the couch, you need to copy left side of the couch.

1.	 Activate the Top viewport. Make sure left side is selected.

2.	 Choose the Select and Move tool. Next, move the cursor over the horizontal axis; it turns 
yellow. Press and hold the SHIFT key and the left mouse button, and then drag the cursor 
toward the right side of the couch until the value in the X spinner in the coordinate display 
becomes about 159. Release the left mouse button and the SHIFT key; the Clone Options 
dialog box is displayed. 

                                                       
3.	 In the Clone Options dialog box, make sure that the Copy radio button is selected and the 

value in the Number of Copies spinner is set to 1. In the Name text box, enter right side 
and choose OK; right side of the couch is displayed, as shown in Figure 3-23. 

Creating Base of the Couch
To create the base of the couch, you need to create another chamfer box.

1.	 Activate the Top viewport and choose the ChamferBox tool. In the Keyboard Entry rollout, 
set the following parameters:
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	 X: 0		  Z: -12.0			  Length: 62.782		
	 Width: 172.0	 Height: 15.0 		  Fillet: 6.0	

	 Make sure 0 is entered in the Y spinner. 

2.	 Choose the Create button; another chamfer box is created, as shown in Figure 3-24.

Figure 3-23  The right side geometry displayed in the viewports

Figure 3-24  The base geometry displayed in the viewports
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3.	 In the Name and Color rollout, enter base as the name of the chamfer box and press the 
ENTER key.

4.	 Assign the same color to base that you assigned to seat support. 

5.	 Make sure the Top viewport is activated and then choose the ChamferCyl tool. In the 
Keyboard Entry rollout, set the following parameters:

	 Radius: 5.0		  Height: 5.0		  Fillet: 1.0

	 Choose the Create button; a chamfer cylinder is created. 

6.	 In the Name and Color rollout, enter support1 and press the ENTER key. Assign black 
color to it. Next, align it at the bottom left corner of base, as shown in Figure 3-25.

Figure 3-25  The support1 geometry aligned in the viewports

7.	 Create three copies of support1 as discussed earlier and align them, as shown in Figure 3-26.

Saving and Rendering the Scene
In this section, you will save and then render the scene. You can also view the final rendered 
image of this scene by downloading the c03_3dsmax_2020_rndr.zip file from www.cadcim.com. The 
path of the file is as follows: Textbooks > Animation and Visual Effects > 3ds Max > Autodesk 3ds 
Max 2020: A Comprehensive Guide

1.	 Change the background color of the scene to white, as discussed in Tutorial 1 of Chapter 2 .

2.	 Choose Save from the File menu.
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Figure 3-26  All supports aligned in viewports

3.	 Activate the Perspective viewport and then choose the Render Production tool from the 
main toolbar; the Rendered Frame window is displayed. This window shows the final output 
of the scene, refer Figure 3-27.

Figure 3-27  The final output after rendering 

Tutorial 2
In this tutorial, you will create the model of a chair, as shown in Figure 3-28, using the 
extended primitives and modifiers.                                                      (Expected time: 40 min)
	
The following steps are required to complete this tutorial:  

a.	 Create the project folder.
b.	 Create seat support.
c.	 Create back support.
d.	 Create spring support.
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e.	 Create leg support.
f.	 Create legs.
g.	 Create the rollers for legs.
h.	 Create right hand support.
i.	 Create left hand support.
j.	 Save and render the scene.

Figure 3-28  The model of a chair

Creating the Project Folder
Create a new project folder with the name c03_tut2 at \Documents\3dsmax2020 and then save the 
file with the name c03tut2, as discussed in Tutorial 1 of Chapter 2.

Creating Seat Support
In this section, you need to create a chamfer box primitive to create seat support of the chair.

1.	 Activate the Top viewport. Choose Create > Geometry from the Command Panel; the 
Standard Primitives option is displayed by default in the drop-down list. Select the 
Extended Primitives option from the list and then choose the ChamferBox tool from the 
Object Type rollout.

2.	 Expand the Keyboard Entry rollout and set the values as follows:

	 Length: 90.0	 	 Width: 100.0			   Height: 17.0
	 Fillet: 10.0		

3.	 Choose the Create button; a chamfer box is created.

4.	 Make sure the chamfer box is selected. In the Parameters rollout, set the value 10 in the 
Fillet Segs spinner; the chamfer box is modified, as shown in Figure 3-29.  

5.	 In the Name and Color rollout, enter seat support as the name of the chamfer box and 
press ENTER. 

6.	 Use the color swatch to modify the color of seat support by entering the values as follows:

	 Red: 88			   Green: 199			   Blue: 225
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Creating Back Support
In this section, you will use the ChamferBox tool from the extended primitives to create back 
support for the chair.

Figure 3-29  The chamfer box created for seat support of the chair

1.	 Activate the Front viewport and make sure that the ChamferBox tool is chosen. 

2.	 Expand the Keyboard Entry rollout and set the values as follows:

	 X: 0.0		  Y: 65.0			   Z: -65.0			  Length: 90.0		
Width: 100.0	 Height: 19.633		  Fillet: 10.0

3.	 Choose the Create button; a chamfer box is created. In the Parameters rollout, make sure 
the value in the Fillet Segs spinner is 10 and enter back support as the name of the chamfer 
box in the Name and Color rollout, refer to Figure 3-30. 

4.	 Choose the color swatch and assign the same color to back support that you assigned to seat 
support.

5.	 Choose the Zoom Extents All tool to display the objects properly in all viewports.

	 Next, you need to create the spring support to join seat and back support.
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Figure 3-30  The back support geometry in viewports

Creating Spring Support
In this section, you will create spring support by using the Hose tool from the extended primitives.

1.	 Activate the Top viewport. Choose Create > Geometry from the Command Panel. Make 
sure that the Extended Primitives option is selected in the drop-down list and then choose 
the Hose tool from the Object Type rollout.

2.	 In the Top viewport, press and hold the left mouse button and drag the cursor to specify 
the radius of the hose, and then release the left mouse button. Next, move the cursor up to 
specify the height of the hose and click on the viewport; a hose is created.

3.	 In the Name and Color rollout, enter spring support as the name of the hose and press 
ENTER. Also, modify the color of spring support to black.

4.	 In the Hose Parameters rollout, set the values of spring support as follows:

 	 End Point Method Area
	 Make sure that the Free Hose radio button is selected.

	 Free Hose Parameters Area
	 Height: 25.815
	
	 Common Hose Parameters Area
	 Cycles: 9

	 Use the default values for the other options in this area.
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	 Smoothing Area
	 Make sure the All radio button is selected.

	 Hose Shape Area
	 Make sure the Round Hose radio button is selected.

	 Diameter: 15.0		  Sides: 8

	 After setting the values in the Hose Parameters rollout, align spring support in the viewports, 
as shown in Figure 3-31.

Figure 3-31  The spring support geometry in viewports

	 Next, you will apply the Bend modifier to spring support to join seat and back support.

5.	 Make sure spring support is selected and then choose Modifiers > Parametric Deformers > 
Bend from the menu bar; the Bend modifier is displayed in the modifier stack. Also, the 
Parameters rollout is displayed in the Modify tab.

6.	 In the Parameters rollout of the Bend modifier, set the values as follows:
  
	 Bend Area
	 Angle: 90.0		 Direction: 90

	 Bend Axis area 
	 Make sure the Z radio button is selected.

7.	 After entering the values, spring support is displayed, as shown in Figure 3-32.
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Figure 3-32  The spring support geometry after applying the Bend modifier

	

	 Next, you will align spring support.
	
8.	 Activate the Left viewport and make sure that spring support is selected. Choose the Zoom 

Extents Selected tool; spring support is zoomed in the Left viewport, as shown in Figure 3-33.

9.	 Right-click on the Select and Rotate tool; the Rotate Transform Type-In dialog box is 
displayed. In the Offset: Screen area, set 90 in the Z spinner and press ENTER; spring support 
is rotated, as shown in Figure 3-34. Now, close the Rotate Transform Type-In dialog box.

Figure 3-33  The spring support geometry 
zoomed in the Left viewport

Figure 3-34  The spring support geometry 
rotated in the Left viewport

10.	 Choose the Select and Move tool and align spring support, as shown in Figure 3-35.

11.	 Choose the Zoom Extents All tool to display all the objects properly in the viewports, refer 
to Figure 3-36.
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Figure 3-35  Alignment of spring support in the Left viewport

Figure 3-36  Alignment of spring support in the viewports 

Creating Leg Support
Now, you need to create leg support. You will use the Hose tool from the extended primitives 
to create it.

1.	 Activate the Top viewport and then create a hose object as discussed earlier. 

2.	 In the Name and Color rollout, enter leg support as the name of the hose and press ENTER. 
Also, modify the color of leg support to black.

3.	 In the Hose Parameters rollout, set the values of leg support as follows:

	 End Point Method Area

	 Make sure that the Free Hose radio button is selected.
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	 Free Hose Parameters Area
	 Height: 42.0

	 Common Hose Parameters Area
	 Make sure that the Flex Section Enable check box is selected.

	 Starts: 22.0		  Ends: 82.0	
	 Cycles: 10		

	 Make sure the value in the Diameter spinner is -20.0.	

	 Smoothing Area
	 Make sure the All radio button is selected.
	 Hose Shape Area
	 Make sure the Round Hose radio button is selected.

	 Diameter: 17.0	 Sides: 8

4.	 Choose the Select and Move tool and align leg support in the viewports, as shown in 
Figure 3-37.

Figure 3-37  Alignment of leg support in the viewports 

Creating Legs
In this section, you will use the ChamferBox tool from Extended Primitives to create legs of 
the chair.

1.	 Activate the Top viewport and choose the ChamferBox tool. 



Extended Primitives		         3-29

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

2.	 Expand the Keyboard Entry rollout and set the values as follows:

	 X: -29		  Y: 0.0			   Z: -42.0			  Length: 5.748	 	
Width: 44.0		 Height: 7.0		  Fillet: 2.0

		
3.	 Choose the Create button; a chamfer box is created.

4.	 Make sure the chamfer box is selected. In the Parameters rollout, set the values as follows:

	 Length Segs: 10	    	 Width Segs: 10	 	 Height Segs: 10		
	
	 Make sure the value in the Fillet Segs is 10. 
	 After entering the values, the chamfer box is modified.  

5.	 In the Name and Color rollout, enter leg01 as the name of the chamfer box and press 
ENTER. Also, modify its color to black.

6.	 Choose the Select and Move tool and align leg01 with leg support in the viewports, as shown 
in Figure 3-38. 

Figure 3-38  Alignment of leg01 in the viewports

	 Now, you need to apply the Taper modifier to leg01 to taper it.

7.	 Make sure that leg01 is selected, and then choose the Zoom Extents All Selected tool; leg01 
is zoomed in all viewports, as shown in Figure 3-39.
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Figure 3-39  The leg01 geometry after invoking the Zoom Extents All Selected tool  

8.	 Choose Modifiers > Parametric Deformers > Taper from the menu bar; the Taper modifier 
is displayed in the modifier stack. Also, the Parameters rollout is displayed in the Modify 
tab.

9.	 In the Parameters rollout of the Taper modifier, set the values as given below:
  
	 Taper Area
	 Amount: 0.53 

	 Taper Axis Area
	 Select the X radio button in the Primary group and make sure the ZY radio button is selected 

in the Effect group.  

10.	 After entering the values, leg01 is tapered, as shown in Figure 3-40.

Creating the Rollers for Legs
In this section, you will create rollers. You will use the chamfer box and chamfer cylinder 
primitives to create them.

1.	 Activate the Top viewport and choose the ChamferBox tool.

2.	 Expand the Keyboard Entry rollout and set the values as follows:

	 X: -40			   Y: 0.0			   Z: -20.0		 Length: 7.032	 	
Width: 14.816		  Height: 1.799		  Fillet: 1.0
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Figure 3-40  The leg01 geometry displayed in viewports after applying the Taper modifier

3.	 Choose the Create button; a chamfer box is created.

4.	 Make sure that the chamfer box is selected. In the Parameters rollout, make sure the value 
in the Length Segs, 	Width Segs, Height Segs, and Fillet Segs spinners is 10.

5.	 In the Name and Color rollout, enter box01 as the name of the chamfer cylinder. Also, 
modify its color to black.

Note
To view box01 in viewports, you need to adjust the view by invoking the Zoom and Pan View tools.

	 Next, you will apply the Bend modifier to box01.

6.	 Choose Modifiers > Parametric Deformers > Bend from the menu bar; the Bend modifier is 
displayed in the modifier stack. Also, the Parameters rollout is displayed in the Modify 
panel.

7.	 In the Parameters rollout of the Bend modifier, set the values as follows:

  	 Bend Area
	 Angle: 173.5
	 Bend Axis Area 
	 Select the X radio button.
	
8.	 After applying the Bend modifier, box01 is displayed, as shown in Figure 3-41.
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Figure 3-41  The box01 geometry displayed in viewports after applying the Bend modifier

	 Next, you need to create a chamfer cylinder.

9.	 Make sure the Extended Primitives option is selected in the drop-down list of the Command 
Panel. Now, choose the ChamferCyl tool from the Object Type rollout.

10.	 Activate the Top viewport and expand the Keyboard Entry rollout. Set the values as follows:

	 X: -40			   Y: 0.0			   Z: -20.0
	 Radius: 5.0	 		  Height: 7.0		  Fillet: 1.0	

11.	 Choose the Create button; a chamfer cylinder is created. 

12.	 Make sure the chamfer cylinder is selected. In the Parameters rollout, set the values as 
follows:  

	 Height Segs: 10	 	 Fillet Segs: 10		  Cap Segs: 11

	 Make sure the value in the Sides spinner is 12 and the Smooth check box is selected. 

13.	 In the Name and Color rollout, enter cylinder01 as the name of the chamfer box and press 
ENTER. Also, modify the color of chamfer box by specifying the values as follows:

	 Red: 151			   Green: 151		  Blue: 151	

14.	 Align cylinder01 with box01 in the viewports using the Select and Rotate and Select and 
Move tools, refer to Figure 3-42.
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Figure 3-42  Alignment of cylinder01 with box01 in viewports

	 Next, you need to group cylinder01 and box01.

15.	 Select cylinder01 and box01 from the Scene Explorer and right-click; a quad menu is displayed. 
Choose Add Selected to > New Group from the quad menu; the Group dialog box is 
displayed.

16.	 Enter roller01 in the Group name text box and choose the OK button; the group is named 
as roller01.

17.	 Using the Select and Move and Select and Rotate tools, align roller01 with leg01 in all 
viewports, as shown in Figure 3-43.

18.	 Group leg01 and roller01 as f_leg01 as done earlier.

19.	 Choose the Zoom Extents All tool to view all the objects in the viewports.

	 Next, you need to create other legs for the chair using the same dimensions. To do so, you 
need to copy f_leg01.  

20.	 Activate the Top viewport and make sure f_leg01 is selected. Now, choose the Hierarchy  
tab from the Command Panel. In the Pivot tab, choose the Use Working Pivot button 
in the Working Pivot rollout; a gizmo is displayed at the center of the scene. 

	 Also, the USE WP text is displayed below the viewport label in the viewports. 
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Figure 3-43  Alignment of roller01 with leg01 in viewports

	 The working pivot point enables you to rotate f_leg01 about an arbitrary and persistent 
point in the scene without affecting the original pivot point of the object.

21.	 Activate the Top viewport and then choose the Select and Rotate tool; a circular gizmo is 
displayed, as shown in Figure 3-44.

22.	 Move the cursor over the Z-axis that is blue in color; it get highlighted in yellow color. Now, 
press and hold the SHIFT key as well as the left mouse button and drag the cursor until the 
value in the Z spinner in the coordinate display is around -72, refer to Figure 3-45. Release 
the left mouse button; the Clone Options dialog box is displayed. Make sure that the 
Copy radio button is selected. Set 4 in the Number of Copies spinner. Choose the OK 
button;  f_leg002, f_leg003, f_leg004, and f_leg005 are displayed in the viewports, as shown 
in Figure 3-46.    

Figure 3-44  A circular gizmo displayed at the 
location of the working pivot point

Figure 3-45  The f_leg01 group rotated about -72 
degrees with respect to the working pivot point
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Figure 3-46  The f_leg002, f_leg003, f_leg004, and f_leg005 in viewports

23.	 Click and deactivate the Use Working Pivot button in the Working Pivot rollout; the cursor 
moves to its original position. Also, the USE WP text disappears from the viewport label in 
the viewports.

Creating Right Hand Support
In this section, you will use the Box tool from Standard Primitives to create right hand support 
of the chair.

1.	 Activate the Top viewport and choose Create > Geometry from the Command Panel. Now, 
select the Standard Primitives option from the drop-down list. Also, choose the Box tool 
from the Object Type rollout.

2.	 Expand the Keyboard Entry rollout and set the values as follows:

  	 Length: 5.515	 	 Width: 9.0		  Height: 55.0

3.	 Choose the Create button; a box is created.

4.	 In the Parameters rollout, set the values as given below:  

	 Length Segs: 15		  Width Segs: 15		  Height Segs: 15	

Note
The more the number of segments in an object, the smoother will be its surface when you apply a 
modifier to it. 
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5.	 In the Name and Color rollout, enter right hand support01 as the name of the box and 
press ENTER. Also, change its color to black. Next, you need to apply the Bend modifier 
to right hand support01 to give it the shape of a hand rest.

6.	 Make sure that right hand support01 is selected and then apply the Bend modifier to it as 
discussed earlier. 

7.	 In the Parameters rollout of the Bend modifier, set the parameters as follows:
  
	 Bend Area		
	 Angle: 107.5	 Direction: 270.0
	 Bend Axis Area

	 Make sure the Z radio button is selected.

8.	 Align right hand support01 in all viewports, as shown in Figure 3-47.

Figure 3-47  Alignment of right hand support01 in viewports

	 Next, you need to create the second part of right hand support01. To do so, you need to copy 
right hand support01.

9.	 Activate the Top viewport, select right hand support01, and then create its copy; the copy is 
automatically named as right hand support002. 

10.	 In the Parameters rollout of the Bend modifier, set the values as follows:
  
	 Bend Area
	 Angle: 90		  Direction: 180
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	 Bend Axis Area
	 Make sure the Z radio button is selected.
	
	 Limits Area
	 Select the Limit Effect check box.
	 Upper Limit: 18.0

11.	 After entering the values, right hand support002 is modified, as shown in Figure 3-48.

Figure 3-48  The right hand support002 geometry after modifying the values of the Bend modifier

12.	 Align right hand support002 in viewports using the Select and Move and Select and Rotate 
tools, as shown in Figure 3-49.

Note
You can use the Orbit tool in the Perspective viewport to view the proper alignment of right hand 
support002 in viewports. 

13.	 Select right hand support01 and right hand support002 and group them as right hand 
support.                        	

14.	 Choose the Zoom Extents All tool to view all the objects in the viewports.

Creating Left Hand Support
In this section, you will create a copy of right hand support to create a support for the left hand.

1.	 Activate the Top viewport, select right hand support.
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Figure 3-49  Alignment of right hand support002 in viewports

2.	 Choose the Mirror tool from the Main Toolbar; the Mirror: Screen Coordinates 
dialog box is displayed, as shown in Figure 3-50.

3.	 In this dialog box, make sure that the X radio button is selected in the Mirror Axis area and 
set -81.4 in the Offset spinner. Next, select the Copy radio button in the Clone Selection 
area and then choose the OK button. 

	 Figure 3-51 shows left hand support in the viewports. 

Saving and Rendering the Scene
In this section, you will save and then render the scene. You can also 

Figure 3-50  The Mirror: Screen 
Coordinates dialog box

view the final rendered image of this scene by downloading the 
c03_3dsmax_2020_rndr.zip file from www.cadcim.com. The path 
of the file is as follows: Textbooks > Animation and Visual Effects > 
3ds Max > Autodesk 3ds Max  2020: A Comprehensive Guide

1.	 Change the background color of the scene to white by 
following the steps given in Tutorial 1 of Chapter 2 .

2.	 Choose Save from the File menu.

3.	 Activate the Perspective viewport. Next, choose the Render 
Production tool from the Main Toolbar; the Rendered 
Frame window is displayed showing the final output of the 
scene, refer to Figure 3-52. 
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Figure 3-51  The left hand support geometry in viewports

Figure 3-52  The final rendered output 

 Self-Evaluation Test 
 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 Which of the following modifiers is used to bend an object along its axis?
	
		  (a) Bend		  		  (b) Taper
		  (c) Percent Snap Toggle			  (d) None of these
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2.	 Which of the following tools in the extended primitives, when invoked, do not display the 
Creation Method and Keyboard Entry rollouts?

		  (a) RingWave	 			   (b) Hedra		
		  (c) Hose	 			   (d) All of these	

3.	 Which of the following radio buttons is selected by default in the RingWave Timing area 
of the Parameters rollout?

		  (a) No Growth				    (b) Cyclic Growth
		  (c) Grow and Stay			   (d) None of these

4.	 Which of the following spinners is used to bevel the top and bottom cap edges of a chamfer 
cylinder?

		  (a) Sides				    (b) Fillet
		  (c) Cap Segs				    (d) Fillet Segs

5.	 The value in the __________ spinner in the Bend area of the Bend modifier is used to define 
the angle of bend along the X, Y, or Z axis.

6.	 The options in the __________ area are used to change the shape of the outer edge of the 
ringwave and define the breakup of the outer edge.

7.	 The __________ spinner in the Taper area of the Taper modifier is used to define the amount 
of taper.

  
8.	 You can modify the height of the free hose by setting the value in the __________ spinner 

of the Free Hose Parameters area. (T/F)
	
9.   In the RingWave Size area, the Radius spinner is used to define the outer radius of the 

ringwave. (T/F)

10.	 The options in the Inner Edge Breakup area are used to change the shape of the inner 
edge of the ringwave. (T/F)

 Review Questions 
Answer the following questions:

1.	 Which of the following command sequences is followed to create a hedra from the Command 
Panel?

		  (a) Create > Extended Primitives > Hedra
		  (b) Create > Geometry > Extended Primitives > Object Type rollout > Hedra
		  (c) Create > Standard Primitives > Hedra
		  (d) Create > Shape > Extended Primitives > Object Type rollout > Hedra
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2.	 Which of the following radio buttons is selected by default in the Family area of the 
Parameters rollout while creating a hedra?

		  (a) Tetra				    (b) Star1
		  (c) Star2				    (d) Dodec/Icos

3.	 Which of the following three shapes of the polygonal facets of a polyhedron in the Axis 
Scaling area?

		  (a) triangle, square, and rectangle	 (b) triangle, square, and octagon
		  (c) triangle, square, and pentagon	 (d) triangle, square, and hexagon 

4.	 Which of the following spinners is used to specify the number of segments in the fillet of a 
chamfer box?

		  (a) Fillet				    (b) Width Segs
		  (c) Height Segs				   (d) Fillet Segs

5.	 Which of the following is an extended primitives?

		  (a) Capsule				    (b) Chamfer Box
		  (c) Chamfer Cylinder			   (d) All of these

6.	 In the Parameters rollout of the Taper modifier, the Primary area is used to define the  
__________ axis and the Effect area is used to define the __________ from the primary axis.

7.	 In the Limits area of the Parameters rollout of the Bend modifier, the default value in the 
Upper Limit and Lower Limit spinner is __________. 

8.	 In the Parameters rollout of the chamfer cylinder, the Slice On check box is used to 
specify the start and end angle of the chamfer cylinder. (T/F)

9.	 The Taper modifier is used to bend an object in angular increments. (T/F)

10.	 In the Family Parameters area of the Parameters rollout of the hedra, the combined value 
of the P and Q spinners can be either equal to or less than 1.0. (T/F)

EXERCISES
The rendered output of the models used in the following exercises can be accessed by downloading 
the c03_3dsmax_2020_exr.zip from www.cadcim.com. The path of the file is as follows: Textbooks > 
Animation and Visual Effects > 3ds Max > Autodesk 3ds Max 2020: A Comprehensive Guide

 Exercise 1                                                                                                         
Create the model of a stool shown in Figure 3-53 using your own dimensions. 

	                                                                                                   (Expected time: 30 min)
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Figure 3-53  The model of a stool

 Exercise 2                                                                                                                                            
Create the models shown in Figures 3-54 and 3-55 by using your own dimensions.             	

                                                                                                       (Expected time: 30 min) 
  
   
    

     

Figure 3-55  The model of a chairFigure 3-54  The model of a table

	

Answers to Self-Evaluation Test
1. a, 2. d, 3. a, 4. b, 5. Angle, 6. Outer Edge Breakup, 7 Amount, 8. Height, 9. T, 10. T


